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Graphene structure                                                          
SystemName graphene
#                  Graphene layer
#                  MeshCutoff: 600 Ry
#                  20 x 20 x 1 Monkhorst-Pack mesh

SystemLabel graphene

LatticeConstant 1.47030 Ang
# Nearest-neighbor distance, d
# The primitive translation vectors
# will be given by
# a_{1} = (3/2 d, - sqrt(3)/2 d, 0)
# a_{2} = (3/2 d, + sqrt(3)/2 d, 0)
# Here the z-component of the vectors
# is large enough to avoid interactions
# between periodic replicas of the slab

%block LatticeVectors
1.500       -0.8660254038        0.000
1.500        0.8660254038        0.000
0.000        0.0000000000       20.000

%endblock LatticeVectors

AtomicCoordinatesFormat Fractional
%block AtomicCoordinatesAndAtomicSpecies

0.3333333333   0.3333333333   0.000  1
0.6666666667   0.6666666667   0.000  1

%endblock AtomicCoordinatesAndAtomicSpecies

begin unit_cell_cart
Ang
2.20545 -1.27331715120714  0.000
2.20545  1.27331715120714  0.000
0.000    0.00000000000000 29.406000
end unit_cell_cart

begin atoms_frac
C1        0.3333333333   0.3333333333   0.0000000000
C2        0.6666666667   0.6666666667   0.0000000000
end atoms_frac

graphene.win

graphene.fdf

Here, the same lattice vectors,       
but in Angstrom, 

not in unit of the lattice constant.



Graphene: plotting the band-structure in SIESTA

4

#
# Plotting the band structure
#

BandLinesScale ReciprocalLatticeVectors
%block BandLines
1 0.0 0.0 0.0 \Gamma # Begin at \Gamma
50 0.33333 0.666667 0.0 K # 50 points from \Gamma to K
50 0.5 0.5 0.0 M # 50 points from K to M
50 0.0 0.0 0.0 \Gamma # 50 points from M to \Gamma
%endblock BandLines

#
# Plotting the Projected Density Of States
#

%block ProjectedDensityOfStates
-70.00 5.00 0.150 3000 eV

%endblock ProjectedDensityOfStates

%PDOS.kgrid_Monkhorst_Pack
60 0 0 0.5
0 60 0 0.5
0 0 2 0.5

%end PDOS.kgrid_Monkhorst_Pack
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Specification of the number of bands to Wannierize

We are interested in project over the
wannierization over the three sp2 orbitals

and the manifold
(five Wannier functions in total)

We have eight bands in the outer
energy window

num_bands =  8     ! Number of bands in the first-principles calculation
!   used to form the overlap matrices
!   seedname.mmn file
!   Default: num_bands = num_wann

num_wann =  5     ! Number of Wannier functions to be found
!   There must be as many projectors in the
!   projections bloch as num_wann functions here.
!   If num_wann < num_bands, then the disentaglement
!   procedure is activated

# Variables related with the Wannierization of the manifold
Siesta2Wannier90.WriteMmn       .true.
Siesta2Wannier90.WriteAmn       .true.
Siesta2Wannier90.WriteEig       .true.
Siesta2Wannier90.WriteUnk       .true.

Siesta2Wannier90.NumberOfBands   8
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graphene.win

graphene.fdf



Entangled bands
In many applications, the bands of interest are not isolated.

The desired bands lie within a limited energy range, but overlap and hybridize
with other bands that extend further out in energy

Which states to choose to form WFs, particularly in those regions of     space
where the bands of interest are hybridized with other unwanted bands?
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Graphene

We are interested in project the
wannierization over the three sp2 orbitals

and the manifold
(five Wannier functions in total)

At this point, the p bands
are crossed by other

unwanted bands
sp2

p/p*



Entangled bands

The problem of computing well localized WFs starting from
entangled bands is broken down into two distint steps

Subspace selection

Gauge selection

For a given point, a prescription is needed for constructing
states from a linear combination of the states of the larger manifold

Once a suitable -dimensional manifold has been identified at each , 
apply the same procedure than for isolated manifolds to generate

localized WFs spannig that manifold

If the -dimensional Bloch
manifold is constructed so it

varies smoothly as a function of 

Then the corresponding WFs
are well localized



Entangled bands

The problem of computing well localized WFs starting from
entangled bands is broken down into two distint steps

Subspace selection

For a given point, a prescription is needed for constructing
states from a linear combination of the states of the larger manifold
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sp2

p/p*

We are interested in project the
wannierization over the three sp2 orbitals

and the manifold
(five Wannier functions in total)

For all the points, 
we should construct five Bloch-like functions, 

since we are interested in five Wanniers
We start with a larger set of Bloch bands,      , lying:
- Within a given energy window (the outer window)
- Within a specified range of bands

In our example, the energy window contains 8 bands at 
some points, while we are interested in five Wanniers



Entangled bands: subspace selection via projection

Starting point: 
A set of       localized trial wave functions

Project each of them onto the space spanned by the chosen eigenstates at each

The same as before, but the overlap matrix is rectangular

We then orthonomarlize the resulting orbitals to produce 
a set of      smoothly varying Bloch-like functions

Same procedure as with the disentangled bands, but with rectangular           matrix



Example: band structure of Si

wherever higher unoccupied and unwanted states possessing
some significant sp3 character are admixed into the projected
manifold. This behavior can be avoided by forcing certain
Bloch states to be preserved identically in the projected
manifold; we refer to those as belonging to a frozen ‘‘inner’’
window, since this is often the simplest procedure for select-
ing them. The placement and range of this frozen window
will depend on the problem at hand. For example, in order to
describe the low-energy physics for, e.g., transport calcula-
tions, the frozen window would typically include all states in
a desired range around the Fermi level.

We show as circles in Fig. 5 the results obtained by forcing
the entire valence manifold to be preserved, leading to a set of
eight projected bands that reproduce exactly the four valence
bands, and follow quite closely the four low-lying conduction
bands. For the modifications to the projection algorithm
required to enforce a frozen window, we refer to Sec. III.G
of Souza, Marzari, and Vanderbilt (2001).

Projection techniques can work very well, and an applica-
tion of this approach to graphene is shown in Fig. 6, where the
!=!? manifold is disentangled with great accuracy by a
simple projection onto atomic pz orbitals, or the entire occu-
pied manifold together with the !=!? manifold is obtained
by projection onto atomic pz and sp2 orbitals (one every
other atom, for the case of the sp2 orbitals, although bond-
centered s orbitals would work equally well).

Projection methods have been extensively used to study
strongly correlated systems (Ku et al., 2002; Anisimov et al.,
2005), in particular, to identify a ‘‘correlated subspace’’ for
LDAþU or dynamical mean-field theory (DMFT) calcula-
tions, as will be discussed in more detail in Sec. VII. It has
also been argued (Ku, Berlijn, and Lee, 2010) that projected
WFs provide a more appropriate basis for the study of
defects, as the pursuit of better localization in a MLWF
scheme risks defining the gauge differently for the defect
WF as compared to the bulk. Instead, a straightforward
projection approach ensures the similarity between the WF

in the defect (supercell) and in the pristine (primitive cell)
calculations, and this has been exploited to develop a scheme
to unfold the band structure of disordered supercells into the
Brillouin zone of the underlying primitive cell, allowing a
direct comparison with angle-resolved photoemission spec-
troscopy (ARPES) experiments (Ku, Berlijn, and Lee, 2010).

2. Subspace selection via optimal smoothness

The projection onto trial orbitals provides a simple and
effective way of extracting a smooth Bloch subspace starting
from a larger set of entangled bands. The reason for its
success is easily understood: the localization of the trial
orbitals in real space leads to smoothness in k space. In order
to further refine the subspace selection procedure, it is useful
to introduce a precise measure of the smoothness in k space
of a manifold of Bloch states. The search for an optimally
smooth subspace can then be formulated as a minimization
problem, similar to the search for an optimally smooth gauge.

As it turns out, smoothness in k of a Bloch space is
precisely what is measured by the functional !I introduced
in Sec. II.C.1. We know from Eq. (19) that the quadratic
spread ! of the WFs spanning a Bloch space of dimension J
comprises two positive-definite contributions, one gauge in-

variant (!I), and the other gauge dependent ( ~!). Given such
a Bloch space (e.g., an isolated group of bands, or a group of
bands previously disentangled via projection), we have
seen that the optimally smooth gauge can be found by

minimizing ~! with respect to the unitary mixing of states
within that space.
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FIG. 5 (color online). Band structure of bulk crystalline Si. Solid
lines: Original bands generated directly from a DFT calculation.
Triangles: Wannier-interpolated bands obtained from the subspace
selected by an unconstrained projection onto atomic sp3 orbitals.
Circles: Wannier-interpolated bands obtained with the same proce-
dure and the additional constraint of reproducing exactly the
original valence manifold and parts of the conduction manifold,
using a frozen energy window (see text).

FIG. 6 (color online). Band structure of graphene. Solid lines:
Original bands generated directly from a DFT calculation.
Triangles: Wannier-interpolated bands obtained from the subspace
selected by an unconstrained projection onto atomic pz orbitals.
Circles: Wannier-interpolated bands obtained from the subspace
selected by projecting onto atomic pz orbitals on each atom and
sp2 orbitals on every other atom, and using a frozen energy window.
The lower panels shows the MLWFs obtained from the standard
localization procedure applied to the first or second projected
manifolds (a pz-like MLWF, or a pz-like MLWF and a bond
MLWF, respectively).

1430 Marzari et al.: Maximally localized Wannier functions: Theory . . .

Rev. Mod. Phys., Vol. 84, No. 4, October–December 2012

- We are interested in eigth Wanniers
- We choose as localized trial wave functions eigth atomic like sp3 hybrids
- The outer energy window coincide with the entire energy axis shown

(i.e. We take many more Bloch functions than Wanniers
- The disentangle bands shown as blue triangles

The overall agreement, in general, is good
Significant deviations found wherever higher unoccupied bands and 

unwanted states possessing some significant sp3 character are 
admixed with the projected manifold

N. Marzari et al.
Rev. Mod. Phys. 
84, 1419 (2012)



Example: band structure of Si

wherever higher unoccupied and unwanted states possessing
some significant sp3 character are admixed into the projected
manifold. This behavior can be avoided by forcing certain
Bloch states to be preserved identically in the projected
manifold; we refer to those as belonging to a frozen ‘‘inner’’
window, since this is often the simplest procedure for select-
ing them. The placement and range of this frozen window
will depend on the problem at hand. For example, in order to
describe the low-energy physics for, e.g., transport calcula-
tions, the frozen window would typically include all states in
a desired range around the Fermi level.

We show as circles in Fig. 5 the results obtained by forcing
the entire valence manifold to be preserved, leading to a set of
eight projected bands that reproduce exactly the four valence
bands, and follow quite closely the four low-lying conduction
bands. For the modifications to the projection algorithm
required to enforce a frozen window, we refer to Sec. III.G
of Souza, Marzari, and Vanderbilt (2001).

Projection techniques can work very well, and an applica-
tion of this approach to graphene is shown in Fig. 6, where the
!=!? manifold is disentangled with great accuracy by a
simple projection onto atomic pz orbitals, or the entire occu-
pied manifold together with the !=!? manifold is obtained
by projection onto atomic pz and sp2 orbitals (one every
other atom, for the case of the sp2 orbitals, although bond-
centered s orbitals would work equally well).

Projection methods have been extensively used to study
strongly correlated systems (Ku et al., 2002; Anisimov et al.,
2005), in particular, to identify a ‘‘correlated subspace’’ for
LDAþU or dynamical mean-field theory (DMFT) calcula-
tions, as will be discussed in more detail in Sec. VII. It has
also been argued (Ku, Berlijn, and Lee, 2010) that projected
WFs provide a more appropriate basis for the study of
defects, as the pursuit of better localization in a MLWF
scheme risks defining the gauge differently for the defect
WF as compared to the bulk. Instead, a straightforward
projection approach ensures the similarity between the WF

in the defect (supercell) and in the pristine (primitive cell)
calculations, and this has been exploited to develop a scheme
to unfold the band structure of disordered supercells into the
Brillouin zone of the underlying primitive cell, allowing a
direct comparison with angle-resolved photoemission spec-
troscopy (ARPES) experiments (Ku, Berlijn, and Lee, 2010).

2. Subspace selection via optimal smoothness

The projection onto trial orbitals provides a simple and
effective way of extracting a smooth Bloch subspace starting
from a larger set of entangled bands. The reason for its
success is easily understood: the localization of the trial
orbitals in real space leads to smoothness in k space. In order
to further refine the subspace selection procedure, it is useful
to introduce a precise measure of the smoothness in k space
of a manifold of Bloch states. The search for an optimally
smooth subspace can then be formulated as a minimization
problem, similar to the search for an optimally smooth gauge.

As it turns out, smoothness in k of a Bloch space is
precisely what is measured by the functional !I introduced
in Sec. II.C.1. We know from Eq. (19) that the quadratic
spread ! of the WFs spanning a Bloch space of dimension J
comprises two positive-definite contributions, one gauge in-

variant (!I), and the other gauge dependent ( ~!). Given such
a Bloch space (e.g., an isolated group of bands, or a group of
bands previously disentangled via projection), we have
seen that the optimally smooth gauge can be found by

minimizing ~! with respect to the unitary mixing of states
within that space.
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FIG. 5 (color online). Band structure of bulk crystalline Si. Solid
lines: Original bands generated directly from a DFT calculation.
Triangles: Wannier-interpolated bands obtained from the subspace
selected by an unconstrained projection onto atomic sp3 orbitals.
Circles: Wannier-interpolated bands obtained with the same proce-
dure and the additional constraint of reproducing exactly the
original valence manifold and parts of the conduction manifold,
using a frozen energy window (see text).

FIG. 6 (color online). Band structure of graphene. Solid lines:
Original bands generated directly from a DFT calculation.
Triangles: Wannier-interpolated bands obtained from the subspace
selected by an unconstrained projection onto atomic pz orbitals.
Circles: Wannier-interpolated bands obtained from the subspace
selected by projecting onto atomic pz orbitals on each atom and
sp2 orbitals on every other atom, and using a frozen energy window.
The lower panels shows the MLWFs obtained from the standard
localization procedure applied to the first or second projected
manifolds (a pz-like MLWF, or a pz-like MLWF and a bond
MLWF, respectively).

1430 Marzari et al.: Maximally localized Wannier functions: Theory . . .

Rev. Mod. Phys., Vol. 84, No. 4, October–December 2012

This behavior can be avoided by forcing certain Bloch states to be preserved
identically in the projected manifold; 

We refer to those as belonging to a frozen ‘‘inner’’ window
The placement and range of this window will depend on the problem at hand.

N. Marzari et al.
Rev. Mod. Phys. 
84, 1419 (2012)

Circles: the results obtained by forcing the entire valence manifold to be 
preserved, leading to a set of eight projected bands that reproduce exactly the

four valence bands, and follow quite closely the four low-lying conduction bands

I. Souza et al. Phys. Rev. B 65, 035109 (2001)



Example: band structure graphene

Projection on pz orbitals of C and on three sp2-like orbitals

N. Marzari et al.
Rev. Mod. Phys. 
84, 1419 (2012)

wherever higher unoccupied and unwanted states possessing
some significant sp3 character are admixed into the projected
manifold. This behavior can be avoided by forcing certain
Bloch states to be preserved identically in the projected
manifold; we refer to those as belonging to a frozen ‘‘inner’’
window, since this is often the simplest procedure for select-
ing them. The placement and range of this frozen window
will depend on the problem at hand. For example, in order to
describe the low-energy physics for, e.g., transport calcula-
tions, the frozen window would typically include all states in
a desired range around the Fermi level.

We show as circles in Fig. 5 the results obtained by forcing
the entire valence manifold to be preserved, leading to a set of
eight projected bands that reproduce exactly the four valence
bands, and follow quite closely the four low-lying conduction
bands. For the modifications to the projection algorithm
required to enforce a frozen window, we refer to Sec. III.G
of Souza, Marzari, and Vanderbilt (2001).

Projection techniques can work very well, and an applica-
tion of this approach to graphene is shown in Fig. 6, where the
!=!? manifold is disentangled with great accuracy by a
simple projection onto atomic pz orbitals, or the entire occu-
pied manifold together with the !=!? manifold is obtained
by projection onto atomic pz and sp2 orbitals (one every
other atom, for the case of the sp2 orbitals, although bond-
centered s orbitals would work equally well).

Projection methods have been extensively used to study
strongly correlated systems (Ku et al., 2002; Anisimov et al.,
2005), in particular, to identify a ‘‘correlated subspace’’ for
LDAþU or dynamical mean-field theory (DMFT) calcula-
tions, as will be discussed in more detail in Sec. VII. It has
also been argued (Ku, Berlijn, and Lee, 2010) that projected
WFs provide a more appropriate basis for the study of
defects, as the pursuit of better localization in a MLWF
scheme risks defining the gauge differently for the defect
WF as compared to the bulk. Instead, a straightforward
projection approach ensures the similarity between the WF

in the defect (supercell) and in the pristine (primitive cell)
calculations, and this has been exploited to develop a scheme
to unfold the band structure of disordered supercells into the
Brillouin zone of the underlying primitive cell, allowing a
direct comparison with angle-resolved photoemission spec-
troscopy (ARPES) experiments (Ku, Berlijn, and Lee, 2010).

2. Subspace selection via optimal smoothness

The projection onto trial orbitals provides a simple and
effective way of extracting a smooth Bloch subspace starting
from a larger set of entangled bands. The reason for its
success is easily understood: the localization of the trial
orbitals in real space leads to smoothness in k space. In order
to further refine the subspace selection procedure, it is useful
to introduce a precise measure of the smoothness in k space
of a manifold of Bloch states. The search for an optimally
smooth subspace can then be formulated as a minimization
problem, similar to the search for an optimally smooth gauge.

As it turns out, smoothness in k of a Bloch space is
precisely what is measured by the functional !I introduced
in Sec. II.C.1. We know from Eq. (19) that the quadratic
spread ! of the WFs spanning a Bloch space of dimension J
comprises two positive-definite contributions, one gauge in-

variant (!I), and the other gauge dependent ( ~!). Given such
a Bloch space (e.g., an isolated group of bands, or a group of
bands previously disentangled via projection), we have
seen that the optimally smooth gauge can be found by

minimizing ~! with respect to the unitary mixing of states
within that space.
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FIG. 5 (color online). Band structure of bulk crystalline Si. Solid
lines: Original bands generated directly from a DFT calculation.
Triangles: Wannier-interpolated bands obtained from the subspace
selected by an unconstrained projection onto atomic sp3 orbitals.
Circles: Wannier-interpolated bands obtained with the same proce-
dure and the additional constraint of reproducing exactly the
original valence manifold and parts of the conduction manifold,
using a frozen energy window (see text).

FIG. 6 (color online). Band structure of graphene. Solid lines:
Original bands generated directly from a DFT calculation.
Triangles: Wannier-interpolated bands obtained from the subspace
selected by an unconstrained projection onto atomic pz orbitals.
Circles: Wannier-interpolated bands obtained from the subspace
selected by projecting onto atomic pz orbitals on each atom and
sp2 orbitals on every other atom, and using a frozen energy window.
The lower panels shows the MLWFs obtained from the standard
localization procedure applied to the first or second projected
manifolds (a pz-like MLWF, or a pz-like MLWF and a bond
MLWF, respectively).

1430 Marzari et al.: Maximally localized Wannier functions: Theory . . .

Rev. Mod. Phys., Vol. 84, No. 4, October–December 2012

Why sp2-like orbitals?

Because the valence bands can be considered
as bonding combinations of sp2 hybrids

There will be a maximum of charge shared in a 
symmetric way at the center of the bond



The disentanglement procedure
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Some Bloch states are forced to be 
preserved identically in the projected

manifold; those are referred to as 
belonging to a frozen “inner” window

Frozen
energy
window

We are interested in project over the
wannierization over the three sp2 orbitals

and the manifold (five Wannier
functions in total)

dis_win_min -30.0     ! Bottom of the outer energy window
dis_win_max 5.0     ! Top of the outer energy window
dis_froz_min -30.0     ! Bottom of the inner (frozen) energy window
dis_froz_max -7.5     ! Top of the inner (frozen) energy window



The projection functions

begin projections ! The projections block defines a set of
C1:sp2;pz                     !  localised functions used to generate an
C2:pz                            !  initial guess for the unitary transformations.
end projections

graphene.win

We are interested in obtaining 5 Wannier functions
so

We need five inital projections

Wannier90 allows to introduce:
- Three hydrogenoid functions with sp2 symmetry of one of the C
- The two pz functions, centered on each C



How to run the wannierization

$wannier90.x –pp graphene.win

$siesta < graphene.fdf |tee graphene.out

$mv graphene.eigW graphene.eig

$wannier90.x graphene.win

Run WANNIER90 in preprocessing mode to generate the .nnkp file

Run SIESTA to generate the .mmn, the .amn and the .eigW files 

Change the extension of the .eigW file 

Run again WANNIER90 to perform the wannierization



Output of a succesful run of WANNIER90

Final State
WF centre and spread    1  (  1.102724,  0.636660, -0.000000 )     0.72756529
WF centre and spread    2  (  1.102724, -0.636660,  0.000000 )     0.72756529
WF centre and spread    3  (  2.205452,  0.000000, -0.000000 )     0.72754515
WF centre and spread    4  (  1.470301,  0.000001,  0.000000 )     0.82576316
WF centre and spread    5  (  2.940600, -0.000001, -0.000000 )     0.82564525
Sum of centres and spreads (  8.821801, -0.000001, -0.000000 )     3.83408414

Three sp2 type-Wannier

The manifold



How to plot the Wannier functions
WANNIER90 produces files with the name:

SystemLabel.manifold.X_0000Y.xsf that can be directly plotted with XCRYSDEN

Once XCrySDen starts, click on
File → Open structure (Select your xsf file)

Modify → Number of units drawn 2 (along x) 2 (along y) 1 (along z)
Tools → Data Grid

Click on OK
Then, select: 

Degree of triCubic Spline: 3
Click on Render+/- isovalue

Select the desired isovalue (in this example 0.1)
Submit

graphene.manifold.1_00003.xsf graphene.manifold.1_00004.xsf
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